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2021 FISCAL YEAR END REVIEW

**IMPORTANT** Please remember to follow the USPS-R Fiscal
Year End Checklist when completing your fiscal year end process.

Help>Documentation>User Guide>
Appendix>Checklists>USPS-r Fiscal Year End Checklist

https://wiki.ssdt-ohio.org/display/uspsrdoc/USPSR+Fiscal+Year+End+Checklist




\ 7

YV V V V

PRE;CLOSING OVERVIEW

Life Insurance Premium Payments

Verification System/STRS Advance Configuration amount is zero from
previous fiscal year

Run Reports/ STRS Advance

EMIS staff reporting for year-end cycle/New Fiscal Year

Create new job calendars

New contracts for July 1 start dates




PRE-CLOSING LIFE INSURANCE PREMIUM PAYMENTS

> Life Insurance Premium-Life Insurance Payments

For those employees retiring as of June 30 the Life Insurance
amount can be processed through PayroII/Current or Future

No retirement is withheld on this amount -
- Reference IRS Publication 15-B ok e

Miscellaneous

http://www.irs.gov/pub/irs-pdf/p15b.pdf _mmm

Page 13-15




PRE-CLOSING LIFE INSURANCE PREMIUM PAYMENTS
(continued)

Future Pay Amount

Payroll>Payments-Future ... gyee

Close
Employee * Compensation: *
Lloyd, Shawn Trent - ANON1013 v Position: 2, Desc: Secretary (Comp: NonContract, constantly)  +

Future Pay Amount

Description Pay Type Effective Date Units
Lielnsurance Premiom =~ v | 100
Rate Gross ( Retire Hours
) Applies For
100.000 Retirement
Supplemental Tax Option
Supplemental

None v



Payroll>Payments-Current

PRE-CLOSING LIFE INSURANCE
PAYMENTS (continued

Employee Posiion
(Gross Calculations
Adaglion Asssstance Non Cash Eamings Contract Gross Contracd Gross Wilboul Fuluee Amounls
m 300519 350
Future Gross Cross e Insurance: Premium Hon Cash Eamings
o 300519 00
Hon Cash Taable Benell Posiion Retrement Gross Supplemental Gross
o 300510 00
Fay Type Comperiion Loy Raie G CovtGoss  Housoded Descrgton Aoples For Refrenart
8 | Requiar v Postior v 1000 305109 80000 | ReguiarWages- | ¥ Aples For Retrement
i | Lielnsuance Premum v Postor v 10 m Lk ncurgnce | ClAoples ForRetrement



PRE-CLOSING LIFE INSURANCE PREMIUM PAYMENTS

(continued)

> Life Insurance Premium-Life Insurance Payment

Federal, State nor OSDI taxes are not withheld

Added to wages (Total and Taxable Gross) even though no tax is
withheld (For W2 Reporting Purposes)

Medicare and FICA are withheld when payment is processed

Flag on the Payroll Item Configuration city records controls whether
city tax is withheld.
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PRE-CLOSING LIFE INSURANCE PAYMENTS
(continued)

» Payroll Item
Configuration
-tax will be
withheld
during payroll
if checked

Payroll ltem Configuration

City Tax Annuity Options

Annuity 401 a Annuity 401 k Annuity 403 b
Annuity 408 k Annuity 457 Annuity 501 ¢
Non Wages 125 Other Wages 125

Employer Paid Amounts To Be Taxed

Select Employer Paid Amounts to be Taxed

Available Employer Paid Payroll ltems: Tax Employer Paid Amounts for these Payroll Items:
400 - Metter Services - SERS - >
450 - Hickox Textiles - STRS L

500 - Bowens Mill Landscaping - Annuity

501 - Crawfordville Software - Annuity

502 - Westwood Pro Services - Annuity

503 - Coverdale Motor Services - Annuity -

Tax Employer Amounts

Options
Suppress SSN ID Employer Health Coverage Job Level
~ Medicare Pickup » Tax Non Cash Earn Voluntary
Required Show On Create Wizard

Payee Information

11



Pre-closing LIFE INSURANCE Not Entered Before
last pay

If the Life Insurance Premium Pay Type was NOT USED prior to the last
pay of the calendar year, the Life Insurance payment amount must be
entered under the CORE/ADJUSTMENT JOURNAL in order for the Life
Insurance amount to show correctly on the W2 form and to insure
that the Quarter balances. This amount would only be entered under

the 001 Federal Payroll Item. 12



Pre-Closing-LIFE INSURANCE Payments Not
entered before Last Pay

The W2 Report will automatically adjust the Federal, State, OSDI, City (If applicable) and
Medicare, total and taxable gross amounts. No manual adjustments are needed for the
Gross and Taxable Gross amounts. If the Medicare withholding was paid by the employee,
employer or employee and employer. Adjustments must be made to the Amount Withheld
and Board Amount of Payroll Item. If Medicare is fully board paid (Pickup) then the total
Adjustment should be made to the Board Amount of Payroll Item.
= NOTE: The city is only adjusted when the Payroll Item Configuration setup for the city
payroll item is checked to Tax Non Cash Earnings. In Classic, the Taxable and Total gross
must be manually adjusted. -




Adjustments

PRE-CLOSING-LIFE INSURANCE
PAYMENTS/Adjustments

Adjustment Journal

" Create MNew

Employee

- Save @ Cancel

Wooten, Cory Debra — ANOMNT30

FPayroll item

Type: Federal Tax, Code: 001|

T
Transaction
AFTIount

Description

ate

| Life Insurance

prome

FEL

100 000

To Date Options
=~ hMonth To Date
" Quarter To Date
= Year To Date

" Fiscal Year To Date
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Pre-Closing-LIFE INSURANCE
Payments/Adjustments

Adjustment Journal

¥ Create New |V gEETH @ Cancel

E m ployee M ed ica re E@EIE Gory Debra - ANON130
a m O u nt Wit h h e I d !?;;li_!;;??ﬂ@T.a?_‘e..‘.?.f_"_‘?i??’?_

Amount Withheld

321

| Transactioll Date

\Amount

|Description

To Date Options

+ IMonth To Date

» Quarter To Date

+ Year To Date

+ Fiscal Year To Date

15



Pre-Closing-LIFE INSURANCE

Payments/Adjustments

Adjustment Journal

¥ Create New

Employee

v Save [EoReEN]

| Wooten, Cory Debra - ANON130

BOARD AMOUNT OF

[ Type: Medicare Tax, Code 592

PAYROLL ITEM

Transac#on Date
Amount

Description

Board's Amount of payroll item

EXETY

a0

To Date Options
+ Month To Date
# Quarter To Date
+ Year To Date

+ Fiscal Year To Date

16



Pre-Closing-LIFE INSURANCE
Payments/Adjustments

Adjustment Journal + 2
~ Create New + Save @ Cancel
Employee
‘Weoten, Cory Debra - ANON130 v |
[ ]
Full Medicare
| Type: Medicare Tax, Code: 692 v |

I I c KU I Board's Pickup Amount of Payroll item ~

Transaction Pate ! |

Amount . 2 900”

Description

To Date Options
+ Month To Date
" Quarter To Date
+~" Year To Date
« Fiscal Year To Date
17



e PRE-CLOSING-
LIFE INSURANCE PAYMENTS (continued)

Life Insurance Premium-Life Insurance amounts are not included in total
gross pay charged to USAS

Reports provide special totals for balancing
- Pay Report
- Pay Amount Summary Report
« Quarter Report

The Adjustments grid can be used to filter the data for the year and then a
report can be created by clicking on Report and choosing the Excel Data
format. The Amount can then be totaled using Autosum

18



PRE-CLOSING-
LIFE INSURANCE PAYMENTS (continued)

Report setup in Adjustments

Adjustments
# Crede Incuge Concead QAvamedQuey  &Repot | BN
Employes # Last Name First Name Adjustment Type Transaction Date v Amount Destription Payrollftem Type
I ety
® @ 0 ANONI9 Workman Kalie Lfe Insurane 03/01/2019 20000 Federal Tax
® @ O ANONI Workman Dalton Life Insurance 03012019 100.00 Federal Tax

19



PRE-CLOSING-
STRS ADVANCE CONFIGURATION

» System/STRS Advance Configuration or Core>Organization

- STRS Advance fields should be blank and Advance Mode
Flag unchecked. 1

PE Tl @ Cance

e wn AEALALgELALELEY R

STRS Advance Configuration

Advance Amount 0.00 Advance Amount

‘ Advance Mode Advance Mode
Amount Paif Back 0.00 Amount Paid Back 0 0C




PRE-CLO.S'»IG STRS ADVANCE REPORT

» Go to Reports/STRS Advance-DO NOT GENERATE SUBMISSION FILE

The following reports can be executed now to begin balancing and verification
of data:

» Generate Advanced Positions Report-Similar to STRSAD.TXT in classic

- Program will project days through the end of the fiscal year to
determine jobs to advance and calculation of credit

- Earnings include those in the future

» Generate Non-Advance Positions Report-Similar to Non-Advance.TXT in
classic

&, Generate Advance Fiscal Year To Date Report | & Generate Advanced Positions Report | | & Generate Non-Advanced Positions Report

* cenerafomsson ie 4=—— Do NOT generate file now

21



PRE-CLOSING-
STRS ADVANCE REPORT(continued)

<+ @Generate Advance Fiscal Year To Date Report-Similar to STRSAD.RPT
in classic.
- This is the complete fiscal year-end report for all STRS
employees, including all advanced employees.

22



PRE-CLOSING-
EMIS STAFF DATA

~ Follow the Final L Reporting Checklist-

Help>Documentation>User Guide>USPS & EMIS
Connection>Final L Reporting USPS-R EMIS Checklist

https://wiki.ssdtohio.org/display/uspsrdocFINAL+L+REPORTING+USPSR+EMIS+CHECKST

23



PRE-CLOSING
EMIS STAFF DATA (continued)

» EMIS Staff

> Clear any Long term illness data from prior fiscal year (19-20)

= Go to Core/Employees — On the grid under More/State Reporting check Long
Term lllness

Filter on the grid for any Long Term lliness Days >=1.00.

«  Click on the Mass Change button- under Load Definitions click on Clear
Employee Long Term lliness

«  Click the Execution Mode option
«  Click on the Submit Mass Change button

24



Employees

Include Archived

+ Create | (# Mass Change

Number SSN Last Name First Name Termination Date
@ = o ANON238 999939556 Howard Nathan

Choose mode: Load Definition

= MAINTENANCE Clear Employee Long Term lliness (SSDT) v ©

_ EXECUTION ploy 9 S8ah.x)

Script Parameters Script Definition (Normal Mode)
Name Default Value Property Value
longTermiliness ~ 0.00
v
v
~

Add Property row
Add Parameter row

L — Switch to Advanced Mode

Load Definition
| Clear Employee Long Term lliness (SSDT) » &

|« submit Mass Change

Choose mode:

MAINTENANCE
(=) EXECUTION

’| Script Definition (Normal Mode)

Pre-Cl"Osg EMIS Staff Data (continued)

NOTE: Use column fi

Q Advanced Query & Report &8 More | D Reset
Long Term liiness -
=>1.00
22.00
x Close

Definition Name
Clear Employee Long Term lliness

Import Definition

[ Download Definition

Clear Definition

g or advanced queries above o sefeekgbjects for Mass Change.
1 Employee objects will be modified.

25



Pre-Closing EMIS Staff Data (continued)

» Enter any long term illness (15 or more consecutive
absences) data on the Employee record for the 20-21
school year.

State Reporting

ECE Qualification Degree Type Handicap Status Long Term lliness
4 (Enrolled in Bachelors Degree program in Early Child B v | | 2 (Bachelors) v 3200
Non-Certificate Employee ID Other Credentials Semester Hours

278451622 4 (Working toward an Associate Degree) v

26



e PRE-CLOSING-
EMIS STAFF DATA (continued)

> |If district has not already completed the EMIS year-end reporting
cycle, the following should be done
Create EMIS Contractor CJ and/or EMIS Contracted Service CC
records if applicable
Go to Core/EMIS Entry and click on the appropriate tab(s) and
click the Extract CJ Data Button or the Extract CC Data button

Check Level 1 error reports from EMIS and make any corrections

to staff data and then reload using SIF data collector.
27



PRE-CLOSING-
EMIS STAFF DATA (continued)

EMIS Employee Entry EMIS Position Entry EMIS Contractor (CJ) EMIS Contracted Service (CC)

+ Create = & Extract CJ Data

Employee # = Last Name First Name Position #
® @  © | ANON204 Manning Pat
@ |(# | © | ANON2070 Stafford Rose

EMIS Employee Entry EMIS Position Entry EMIS Contractor (CJ) | EMIS Contracted Service (CC)

+ Create | (# Mass Change E & Extract CC Data |
Federal Tax Id Position Code

® [ © | 465516138 499

Position Description

Driver
Aide

Funding Source

Q Advanced Query

Local ContractCode  IRN

047050
047050

Q Advanced Query
Local Contract Code

999

& Report & More | "D Reset
Position Code FTE

230 0.01000

230 0.01000

& Report B8 More | 'O Reset
Contractor Name

LEAP



MONTH-END CLOSING - SERS PER PAY REPORT & File
» Go to Reports/SERS Per Pay

- Verify the data by clicking on the Generate Report button
- Verify service days for all employees

- Total contributions should equal total deduction and warrant checks
payable to SERS

- Earnings x 10% should equal contributions
» To create the SERS Tape file click on the Generate Submission File button

Save the file to your desktop or a folder of your choosing.
Upload the submission file to eSERS.

29



MONTH-END CLOSING-STRS REPORT & File

> Go to Reports/STRS Report
* Verify the data by clicking on the Generate Report button
* Verify service days for all employees

« Total contributions should equal total deduction and warrant checks payable to
STRS

* Earnings x 14% should equal contributions
> To create the STRS Tape file click on the Generate Submission File button

- Save the file to your desktop or a folder of your choosing.
«  Upload the submission file to STRS.
OR
«  Click the Generate Submission File and Submit to STRS button.
30



MONTH-END CLOSING-
STRS Month Report (optional)

» The STRS Month Report can be processing if desired.
(optional)

» Go to Reports/STRS Monthly Report
» Many districts use this for balancing each month.
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MONTH-END CLOSING-
RECONCILE CHECKS/BENEFIT ACCRUAL

Use Payments/Check Register to reconcile or Auto reconcile checks
> Run Reports/Report Manager/SSDT Outstanding Checks Report or

» Reports/Payment Transaction Status Report to find all outstanding
payments selecting ‘Paid’ for Payment Transaction status Options

» Balance payroll account

» Go to Processing/Benefit Update and Projection and process leave
accruals, if necessary, for the month.

32



QUARTER-END CLOSING-
QUARTER REPORT
> Go to Reports/Quarter Report

Lists all QTD figures from Historical Payroll and any adjustments
for the quarter made in Adjustments.

Compare totals of Outstanding Payables checks written to the
Quarter Report totals for each Payroll Item code

Be cautious of Payroll ltems combined by Payee
Any differences should be resolved

33



QUARTER-END CLOSING-QUARTER REPORT

» Compare the ‘Total Gross’ listed to the total of all payroll clearance checks written

from USAS

>  Subtract gross for payroll checks voided during the quarter from payroll clearance

checks written

oD Toraiac”

Total Gross: $1,428,317.11
Total Annuities: 5222 812.06
Non-Federal Tax $0.00
Annuities:

Non-Cash Earnings: £0,00
Calculated Adjusted £1,205.505.03
Gross:

Total Employees: 297
Total Employee Count Per 941 o
Instructions:

Total Employees Paid in Quarter: 225
Total Emplovees Reportable for ODJFS: o0

Totals Summary

USAS-r>Transaction>Disbursements

A SR Filter on the Date: 04/01/2021..06/30/2021
S siae i e Filter on the Type: Pay roll
$0.00 $0.00
£0.00 $228.00
$1,205.505.03 s4.573,958.00. Check Type Date Type Amount
04/01/2021..08/30/2( payroll
Electronic 05/14/2021 Payroll 476,105.71
Electronic 04/30/2021 Payroll 476,105.71
Electronic 04/15/2021 Payroll 476,105.71

34



QUARTER-END CLOSING-QUARTER REPORT

» Balance ‘Calculated Adjusted Gross’ on the Quarter Report
= The ‘Total Gross’ minus the ‘Total Annuities plus Non-Cash Earnings should
equal the Calculated Adjusted Gross. If off check:

- Verify the total annuities equal total of all Outstanding Payable payments

made to annuity companies

* Go to Reports/Audit Report- look for manual changes to total gross,
applicable gross, Payroll Item annuity amount withheld, federal applicable

gross
- Verify the non-cash amounts

Totals Summary

QTD Total YTD Total FTD Total
Total Gross: $1428.317.01 $1,428,317.11 $5,298 054,34
Total Annuities: — 522281208 $232.812.08
Non-Federal Tax $0.00 §0.00
Annuities:
Non-Cash Earnings: + $0.00 s0.00
Calculated Adjusted S10E505 0T 108, 504,
Gross:

Total Employees: 207

Total Employee Count Per 941 a

Instructions:

Total Employees Paid in Quarter: 225 35
Total Employees Reportable for ODJFS: 0



QUARTER-END CLOSING-QUARTER REPORT
(continued)

» All Payroll Item checks for the quarter should equal the
total Payroll Items showing on quarter report. Be sure to
verify the electronic transfers of federal and Medicare
payments as well. This should be true for every Payroll
[tem.

36



QUARTER-END CLOSING-

W2 PROCESSING
> Go to Reports/W2 Report and Submission

- Balance the W2 Report to minimize problems at calendar year-end
- Prefer to run every Quarter
- Payroll Item totals for taxes
- Payroll Item totals for annuities
» Complete and balance a W2 reconciliation sheet

37



QUARTER-END CLOSING-
OUTSTANDING PAYABLES

> Go to Processing/Process Outstanding Payables
There should be no items listed to pay

- Click on the Payable Report and select all Payroll Items to verify
there are no outstanding Payables

Generally there are no outstanding deductions at quarter-end
If outstanding, make sure to pay those

38
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QUARTER-END CLOSING-ODJFS REPORT oo
> Go to Reports/ODIJFS Report ormicie
- Click on the Generate Report button Lomomtmmn |
« Check all totals and weeks

*Reminder - Taxable wages listed on report is used only for contributing
employers, calculated value based on ODJFS rules. The ODJFS taxable wage

base is $9,000.00 for 2021. If this is met, then zero will be in the YTD
Taxable Wage column.

* When all data is correct, click on the Generate Submission File button
 Save the file to your desktop or folder of your choosing

* Securely send the file to the ACCESS for submission using the ACCESS Secure
Transfer Site

39



FISCAL YEAR-END CLOSING

> After all June pays are completed

= |If aware of early contract payoffs
« Change the number of pays in contract
« Be cautious — pay per period may get changed.

If aware of any docks during the advance enter the dock information
into Future. After the advance has been set the dock can be deleted
from Future and then the dock per pay can be processed
accordingly.

40



FISCAL YEAR-END CLOSING

STRS annual report processing
Go to Reports/STRS Advance

Cli

cli
Cli

IC
IC

IC

< on Generate Advance Fiscal Year To Date Report

< on Generate Advance Positions Report
< on Generate Non-Advanced Positions Report
B " Vhiosa Those NOT
—— PDF (downioad) <] Full report Advancing Advancing
o o ;Gﬁnzamﬁdvance Fiscal ‘r’eari&pﬁdl .‘LGEﬂE{aIeMuar\é ooooooooooooo & Generate Mon-Ady: ﬁ nnnnnnnnnnnn
E.S {'_‘:n_an&r_a_te Submission File

41



FISCAL YEAR-END CLOSING

» The Advance Fiscal Year to Date Report

selects all employees and jobs that were subject to STRS
withholding

All employees with any amount paid during the fiscal year
are listed on the report

Service credit is calculated based on the STRS decision tree

This is the complete fiscal year-end report for all STRS
employees, including all advanced employees.

42



FISCAL YEAR-END CLOSING

»Parameters for job to advance:
1) Work days equal days worked
2) Amount remaining to pay greater than zero
3) Pays greater than pays paid
Will have an accrued contribution amount calculated for

them. This accrued amount will be the amount of earnings
not yet paid times the employee’s STRS withholding rate.

> Accrued contribution amount is calculated using the pay
per period from the Compensation record for the
remaining pays minus 1, then last pay calculation occurs

43



FISCAL YEAR-END CLOSING (continued)

» STRSAD sample calculation

lobligation =39100.00

Pay per period= 1504.00
Pavys/pavys paid= 26/22

2374 pay 1504.00 x 142 = 210.56
24th pbay 1504.00 x _14% = 210.56
25t pay 1504.00 x 14% = 210.56
26™ pavy

Obligation = 39100.00
- Paid 25 pays = 37600.00
Remaining= 1500.00 x 14 26= 210.00

Totaled Accrued wages calculated by STRS Advance:

210.56 + 210.56 + 210.56+ 210.00 = 841.68



FISCAL YEAR-END CLOSING (continued)

» Advance Positions Report
> Lists all employees with an accrued contribution calculation

May be inflated if Increased Compensation flag on 450 is
checked and employee has 691 with inflated rate

> Report should be checked carefully
> Be consistent with prior years
> Check supplemental contracts, many times missed

45



FISCAL YEAR-END CLOSING (continued)

> Non-Advanced Positions Report
> Lists some of the employees with jobs that are not advancing

If job has no amounts remaining to pay but meets all other
criteria

If days worked plus remaining days from calendar through June
30t exceed the total work days

Not a catch of all potential jobs/employees

46



FISCAL YEAR-END CLOSING (continued)

Check reports for warnings and errors-STRS Advance

documentation lists messages and possible solutions
https://wiki.ssdt-ohio.org/display/uspsrdoc/STRS+Advance#STRSAdvance-ErrorsandWarnings
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FISCAL YEAR-END CLOSING (continued)

> Verify service credit
- Employees with 120 or more days receive 100% credit
- Employees with less than 120 days receive credit based on STRS
decision tree
- Employees classified as part-time have service credit based on STRS
decision tree
— Part Time field on 450 must be set as needed
— If uncertain of an employee’s status contact STRS
> Re-employed retirees will always have 0% credit reported with
contributions
- Calculated service credit for rehired retiree will flag a warning

48



FISCAL YEAR-END CLOSING (continued)

» Staff retiring and rehired in the same fiscal year will appear

twice on the report, one line for contributions
retirement, one line for after retirement contri

» Verify the ‘Rehired Retiree’ box is checked on t
employee’s 450 Payroll ltem record

orior to
outions

ne

49



FISCAL YEAR-END CLOSING (continued)

Part Time Employees

Part-time STRS Advance Calculations
Part-Time Employees-Effective July 2020

*  To view the changes online, go to the STRS website: https://www.strsoh.org/employer/ pdfs/guides/50-380.pdf
. Here are the new calculations for Part-time employees:

If less than 90 days worked. Calculate days/180 and calculate actual compensation/$12,000. The Service Credit is
the LESSER of the two calculations.

If greater than 89 and less than 120 days worked. Calculate days/180 and calculate actual
compensation/$12,000. The Service Credit is the LESSER of the two calculations.

If greater than 119 days and salary is less than the state minimum of $30,000. Calculate days/180 and calculate
actual compensation/$12,000. The service Credit is the LESSER of the two calculations.

If greater than 119 days and salary is greater than the state minimum of $30,000. The Service Credit is 1.00 or -
100%.



FISCAL YEAR-END CLOSING (continued)

STRS Part-time decision tree link-
https://www.strsoh.org/employer/_pdfs/fact-sheets/50-314.pdf

STRS Service Credit Guidelines link-
https://www.strsoh.org/ pdfs/brochures/20-551.pdf

51



FISCAL YEAR-END CLOSING (continued)

> Advance Fiscal Year To Date Report

>Balance the amount showing in the ‘Deposit/Pickup’
column included on the report

Should total the outstanding payable checks already
written payable to STRS plus the USAS checks for
pick-up amounts

52



FISCAL YEAR-END CLOSING (continued)

>1f not in balance and can’t resolve at the district
Contact ACCESS as needed: fiscal@access-k12.org
STRS can usually find the problem
STRS balances by employee as well as by district

53
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FISCAL YEAR-END CLOSING (continued)

> Once STRS Advance information is correct, in Reports/STRS Advance
click on the Create Submission File button

Sets advance flag on Compensation records to | StrsAdvance

Places total accrued contribution amount in STRS Advance
Configuration/Advance Amount under System Configuration
as well as checks the Advance Mode box

Creates annual reporting submission file

54



FISCAL YEAR-END CLOSING (continued)

> Print or save final copies of reports as needed
~ FYE Reports will be saved under File Archive/Fiscal Year
Reports

55



FISCAL YEAR-END CLOSING (continued)

~ If third party data (ex. Renhill) needs to be added to the
district STRS Advance tape file, the district does not want
to submit the file to STRS until that spreadsheet
information (in the correct format) has been merged with
the STRS Advance tape file.

~ There will be a STRS Merge in place in USPS-R for fiscal
yvear end reporting. It is currently scheduled to be released
on the 6.40.0 release.

56



FISCAL YEAR-END CLOSING (continued)

- After the merge process has taken place, the district will
then go into Reports/STRS Advance and click on the
Choose file button and find their file and then click on the
Submit Uploaded File to STRS button

57



FISCAL YEAR-END CLOSING (continued)

Go to Reports/ and run SERS Surcharge Report

An additional employer charge is levied on the salaries of lower-paid SERS members. The
minimum annual compensation is determined annually by the System’s actuaries
«  Minimum Annual FY2021 Compensation - $23,000

* Creates a worksheet districts might use for SERS surcharge calculation verification to
compare with the SERS worksheet that was sent

« See https://www.ohsers.org/employers/annual-processes/surcharge/ for complete
details.

* Payment of the Surcharge amount is due within 30 days from notification that the final
Surcharge amount has been calculated. This will need to be completed in the Payment
Remittance application on eSERS.
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FISCAL YEAR-END CLOSING (continued)

» Go to Reports/Auditor of State CSV Report
— Generate Payment History CSV
— Generate Payment Distribution CSV

— Email files to ISA-SchoolSW@ohioauditor.gov

» Go to Reports/Wage Obligation by Employee
— Save the report for SERS Liability Report for the Auditors
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FISCAL YEAR-END CLOSING (continued)

» |If mistakes are found on STRS Advance & a payroll has not
been run, contact ACCESS. We can help you correct the
issue.

» If a payroll has been processed after the advance is set-
Contact STRS and file corrections with STRS
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POST CLOSING

> During the payroll process
« FYTD amounts on the 450, 591 and 691 Payroll Items will show both

Advance amounts and New Earnings. To see what amounts are
Advance, use the ‘Check STRS Advance Report’

« Every payroll, at the bottom of the Pay Report, will show the ‘Payroll
ltem STRS Advancement’ amount

Payroll em Strs Advancement $1175042

> There is a .json file report (STRS Advance.rpd.json) located in the Shared

Reports or Mass Change Definitions—https://wiki.ssdt-
ohio.org/pages/viewpage.action?pageld=82151184 that pulls employees

name, pay dates, STRS Advance Gross, Total STRS Advance and Total STRS
NON Advance amounts.
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Dashboard>Payments

* Click on the payment during the summer that

should’ve been in advance to find the adv amounts
on the payroll items.

Payroll ltems Paid

Type

Federal Tax
Ohio State Tax
City Tax
STRS

Annuity

STRS Annuity
Reqular

Medicare Tax

Code

001
002
004
450
548

. 591

685
693

Applicable Gross

1,443.52
1,44352
1,773.10

0.00
1,773.10

0.00
1,773.10
1,731.75

148.09
32.81
48.76

0.00
41.35
0.00
0.00
2511

Employer Amount = STRS Advance Gross Strs Advance Amount

0.00 0.00 0.00
0.00 l 0.00 0.00
0.00 0.00 0.00

24823 1,773.10 0.00
0.00 0.00 0.00
0.00 1,773.10 24823
6.00 0.00 0.00

251 0.00 0.00

Strs Advance Error Adjustment 2
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Post Closing-
STRS ADVANCE.rpd-json

Reporting Period: March 2020 (FY 2020)

Suwanee (Demo) Schools

STRS Advance

S5/4/20 11:58 AM

Full Nam

Fay Date

Advanced

Strs
Advanced
Wages

Strs

Paviment

Strs
Advan

Total Strs
Advanced

Total Strs
Non
Advanced

trs Advance
ATrmount

Strs Advanc

Adij

Errox
ustment

Full Name:

Abbott, Josh
Chastity
Abbott, Josh
Chastity
Abbott. Josh
Chastity
Abbott. Josh
Chastity
Abbott, Josh
Chastity

Full Name:

Atkinson,_
Danny
Dominic
Atkinson,
Danny
Dominic
Atkinson.
Danny
Dominic
Atkinson,
Danny
Dominic
Atkinson,
Danny
Dominic

Abbott, Josh Chastity

StrsAnnuity
StrsAnnuity
StrsAnnuity
StrsAnnuity

StrsAnnuity

FTIS2019
T/I19/2019
8/2/2019
8/16/2019

a/30/72019

$ 2.045.46
2,045 46
2.045 46
2.045.50

0.00

£
8,181.88

ocoooo

Atkinson, Danny Dominic

StrsAnnuity

StrsAnnuity

StrsAnnuity

StrsAnnuity

StrsAnnuity

FiIS/ 2019

7/19/2019

8/2/2019

8/16/2019

a/303/72019

1.665.23
1.665.23
1.665.23
1.665.25

0.00

s
G GG0._ 94

0 00 0O

$ 286.36
286.36
286.36
286.37

o0.00

1, 145-4;
233.13
233.13
233.13
233.14

0.00

$ 932.53

s 0.00
0.00
0.00
0.00

299 .42

0.00

0.00

0.00

0.00

243.81

s 286.36
286_36
286.36
286.37

0.00

233.13

233.13

233.13

233.14

0.00
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POST CLOSING (continued)

» During advance cycle certain pay types cannot be used on
jobs with advance set as

> REG
> IRR

v Strs Advance
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POST CLOSING (continued)

» Certain pay types affect balance of System/Configuration/ STRS Advance
Configuration advance amount

- DCK (not already accounted for)

- BCK

- TRM (usually creates a few cents difference)
«  POF (usually creates a few cents difference)

» The number of pays can be modified so that pays and pays paid are different by 1
(forcing a contract pay off) the amount on System/Configuration/STRS Advance
Configuration may not balance 65



POST CLOSING (continued)

» The Amount Paid Back in System/Configuration/STRS Advance Configuration
screen, will increase every payroll.

» After all summer pays are complete
- Verify Amount Paid Back is zeroed out.

> After the last pay, if the amount paid back is equal or greater than the
advance amount, then the district will come out of advance and the
advance flag on the configuration is unchecked. When the advance flag on
the configuration is unchecked, then the amount paid back will always
display zero

> If the amount paid back is less than the advance amount after the last pay,
then the advance flag on the configuration will not be unchecked and the
amount paid back will continue to show on the configuration. 66



POST CLOSING (continued)

> If the Pay Back Amount is not zeroed out go to Reports/Check STRS
Advance Report and compare with employee totals on the
Advanced Positions Report to see who’s amount withheld on
accrued earnings does not equal the amount STRSAD calculated

> File corrections with STRS as needed
> Contact ACCESS to review Adva nce status

Edit STRS Adv e Co fg
« Save @ Cancel

AAAAAAAAAAAAA 0.00
Advance Mode

Amount Paid Back 0.00
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NEW FISCAL YEAR 2022

» Payrolls cannot be processed in July until STRS Advance has
been completed. An error is generated: ****RUNNING A

PAYROLL IN JULY BEFORE RUNNING STRS ADVANCE

%k 3%k %k k

» To begin July payroll processing go to Core/Posting Period and
Create a July Posting Period. The Posting Period must be at
least Open 1n order to begin payroll processing. The Posting
Period will need to be set to Current before Payroll Posting

takes place. .



Posting Periods

e Posting Periods — if multiple periods are open, close
each but allow reports to run between closings.

Posting Periods

+Create  Open Periods
Month Name

.May

April
March
February
January
December

November
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* File Archive>Month End Reports
e Month End Reports

SSDT Attendance Journal Report

SSDT Leave Balance Report

SSDT Payment Transaction Status Report
SSDT STRS Monthly Report
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* Quarter

SSD
SSD

SSD1
SSD]
SSD

File Archive>Quarter Reports

End Reports

" Attendance Journal Report

" Leave Balance Report

- Payment Transaction Status Report
" Employee Master Report

" Earnings Register

SSD

" Quarter Report
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File Archive>Fiscal Year End Reports
* Fiscal Year End Reports

SSDT Attendance Journal Report

SSDT Benefit Obligation Report by Account

SSDT Benefit Obligation Report by Employee

SSDT Leave Balance Report

SSDT Payment Transaction Status Report

SSDT Earnings Register

SSDT Wage Obligation Report by Account

SSDT Wage Obligation Report by Employee 72



NEW FISCAL YEAR 2022
EMIS CHECKLIST

Link to the New Fiscal Year EMIS Checklist-
https://wiki.ssdt-ohio.org/pages/viewpage.action?pageld=101057422

Help>Documentation>User Guide>USPS & EMIS

Connection>New Fiscal Year/Initial L Reporting USPS-r
EMIS Checklist
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- Save

| Fiscal Year
Reporting 1d

Z 1d Pre Fix

@ Cancel

"NEW FISCAL YEAR 2022
EMIS CHECKLIST (continued)

> After previous EMIS fiscal year end window L closes go to System/EMIS

Reporting Configuration and change the Fiscal Year (ex. 2021) to the new
Fiscal Year (ex. 2022) Click Save | " gegeew o con

2,024 |

Credential 1}~

EST

+

» Final Period L is scheduled to close on August 6, 2021




NEW FISCAL YEAR 2022
JOB CALENDARS

Job Calendars

Job calendars for the 21-22 school year can be added to the system as soon
as board approved

Utilize Core/Job Calendars

Use one calendar & update it with work days and holidays

The ‘Copy’ function can be used to copy to other job calendars.
Once copied, tweaks specific calendars.

Remember to create a Default calendar

There is a Job Calendar Report available.

Job Calendars must be created prior to New Contracts
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Job Calendars

dolo/elele o oleeeslees
NNNNNNNNNNNEGR

R

"NEW FISCAL YEAR 2022
Job Calendars Copy Option

Payments Payroll -~ Processing ~ Reports ~ System -~ Utilities -~ USAS Integration -~

Copy Job Calendars

+ Mass Change -+ Copy &£ Mass Change .
= b2l < Cancel

(=] axw Copy From Start Date * End Date *
o bez _ axw - automa ~ | 23
o cba
o ccf Copy To
Select Job Calendars .
o dkl Available > | selected
o dty dty - automatically -~ < axw - automaticall ~
o dvn dvn - automaticalh bez - automaticalh
o ekz ekz - automaticall cba - automaticalh
eyc - automatically ccf - automatically
o eyc fck - discovered dkl - headphones
o fck fin - constantly
n ffo - automatically
o fmx - automaticalh
o ffo ghf - automatically
o fmx gpw - automaticall -
o ghf
[x]

apw




NEW FISCAL YEAR 2022
NEW CONTRACTS

> New Contracts

- New contracts can be entered for all employees.

= Go to Processing/New Contracts. One of the following options can
be used

- New Contract Maintenance-Similar to MAINT In NEWCNT
classic

- Mass Copy Compensations-Similar to BUILD in NEWCNT classic
- Import New Contracts-Similar to IMPORT in NEWNT classic
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Releases

* Code — New Compensation Code. Unique per
employee/position

e Save/Recall on many “Canned” reports

e Upcoming: Workflows — Employee Onboarding =
entering a new employee into the payroll system.
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o ﬁomé you;? for coming!
Enjoy your summer!!



